
Modifying 3D Mesh Objects
 
 
Learning Objectives
After completing this chapter, you will be able to:

• Convert objects into editable mesh
• Use sub-object levels
• Convert objects into editable poly
• Convert objects into editable patch
• Modify editable mesh, editable poly, and editable patch objects
 
 
INTRODUCTION
In the previous chapters, you have learned to create different 3D objects and shapes using the tools in
the Create tab of the Command Panel. In this chapter, you will learn to modify the 3D mesh objects
at an advanced level.
 
MODIFYING THE 3D OBJECTS
To modify the 3D objects, select the object and choose the Modify tab in the Command Panel; the
Modify panel will be displayed with various rollouts. In the Modify panel, the default name and color
of the object will be displayed at the top. The modifier stack displays the name of the tools that you
have used for creating the object, as shown in Figure 8-1.

Figure 8-1 The Modify panel
 

Note
The rollouts at the bottom of the Modify panel are displayed based on the type of the object
selected.



 
You can modify the selected object using one of the following methods:
 
1. By entering new parameters in the rollouts displayed in the Modify panel. This has been discussed

in the previous chapters.
 
2. By applying a modifier from the Modifier List drop-down list. You will learn about applying

modifiers in the later chapters.

3. By converting the object into editable mesh, and editable poly, These methods are discussed next.
 
Converting Objects into Editable Mesh
Most of the objects can be modified at advanced level by converting into editable mesh. When open
splines such as line and arc are converted into the editable mesh, only vertices are available because
open splines have no face or edge. When an object is converted into an editable mesh, you get ac cess
to its sub-object levels. These sub-object levels help you to select the sub-objects of an object in the
viewport. You need to move, rotate, and scale these sub-objects to modify the shape of the object.
 
You can convert an object into editable mesh using one of the following methods:
 
1. Create an object and select it in the viewport. Next, right-click on the object; a quad menu will be

displayed. Choose the Convert To: option; a cascading menu will be displayed, as shown in
Figure 8-2. Choose Convert to Editable Mesh from the cascading menu; the object will be
converted into an editable mesh.

2. Create an object and select it in the viewport. Choose the Modify tab in the Command Panel; the
modifier stack will be displayed in the Modify panel. In the modifier stack, right-click on the name
of the tool which has been used to create the object; a shortcut menu will be displayed, as shown in
Figure 8-3. Choose the Editable Mesh option from the shortcut menu; the object will be converted
into an editable mesh.

Figure 8-2 The cascading menu displayed on choosing the Convert To option



Figure 8-3 The shortcut menu displayed
 
3. Create an object and select it in the viewport. Choose the Utilities tab in the Command Panel; the

Utilities rollout will be displayed, as shown in Figure 8-4. Choose the Collapse button in this
rollout; the Collapse rollout will be displayed. Choose the Collapse Selected button in this rollout;
the object will be converted into an editable mesh.

 

Note
After an object is converted into editable mesh using any of the above method, it cannot be
modified using the creation parameters rollouts such as Parameters rollout. So, it is recommended
to set the parameters of an object before converting it into an editable mesh.
 
You need to use the following method to set the parameters of an object even after converting it into

an editable mesh.
 
4. Create an object and select it in the modifier stack. Next, click on the Modifier List drop-down list

and select Edit Mesh from it; the Edit Mesh modifier is applied to the object.
 
Sub-object Levels in Editable Mesh
When you convert an object into an editable mesh using first three methods mentioned above, the
label of the tool in the modifier stack will be replaced by Editable Mesh, which is known as object
level. By clicking on the plus sign (+) on the left side of the Editable Mesh, you can view the sub-
object levels such as Vertex, Edge, Face, Polygon, and Element, as shown in Figure 8-5. Various
rollouts will also be displayed at the bottom of the modifier stack such as Selection, Soft Selection,
Edit Geometry, and Surface Properties. These sub-object levels and rollouts are discussed next.
 
Sub-object Levels
The sub-object levels are used to modify the object by moving, rotating, and scaling the sub-objects.
To do so, select one of the sub-object levels from the modifier stack; the selected sub object will be
activated and turn yellow in the Selection rollout. Alternatively, you can select the Vertex, Edge,
Face, Polygon, or Element sub-object levels by pressing 1, 2, 3, 4, or 5 respectively from the main
keyboard. These sub-objects level are discussed next.



 
Vertex

A vertex is a point on the object. To modify the vertex of the object, select the Vertex sub-object
level from the modifier stack; the vertices of the object will be displayed in the viewport, as shown
in Figures 8-6 and 8-7. The number of vertices depends on the number of segments in the object.

Figure 8-4 The Utilities rollout displayed after choosing the Utilities tab

Figure 8-5 The sub-object levels of an object displayed
 

Figure 8-6 Displaying the vertices of the sphere



Figure 8-7 Displaying the vertices of the box
 

Note
1. You need to set the number of segments in the object before converting it into editable mesh.
 
2. The sub-object components such as Vertex, Edge, Face, Polygon, and Element are not visible
on rendering.

 
Edge

An edge is a line joining two vertices. To modify an edge of the object, select the Edge sub-
object level from the modifier stack and then select the edge(s) of the object, refer to Figures 8-8
and 8-9.
 

Figure 8-8 Selecting the edges of the sphere

Figure 8-9 Selecting the edge of the box
 

Face
A face is a triangular shaped sub-object level formed by joining three vertices and three edges,

as shown in Figure 8-10. To modify faces of the object, select the Face sub-object level from the
modifier stack and then select the triangular faces of the object, as shown in Figure 8-11.



Figure 8-10 The face sub-object level

Figure 8-11 A box with the faces selected
 

Polygon
A polygon is a closed sequence of three or more edges connected by a surface, as shown in

Figure 8-12. To modify polygons of the object, select the Polygon sub-object level from the
modifier stack and then select the polygons of the object, as shown in Figure 8-13.

 

Figure 8-12 The polygon sub-object level

Figure 8-13 A polygon of the box selected
 

Element
An element is a group of two or more objects, as shown in Figure 8-14. To modify the elements

of the object, select the Element sub-object level from the modifier stack and then select element
of the object in the viewport, refer to Figures 8-14 and 8-15.

Figure 8-14 The element sub-object level

Figure 8-15 The element of the box selected
 



Rollouts
When you convert an object into editable mesh, various rollouts will be displayed at the bottom of the
modifier stack in the Modify panel. These rollouts are discussed next.
 

Selection Rollout
The Selection rollout is used to toggle between various sub-object levels. In the Selection rollout,
there are five buttons such as Vertex, Edge, Face, Polygon, and Element. These buttons are used
to select the sub-objects levels of the object in the viewport and are discussed earlier in this
chapter. Choose any of the buttons to activate the sub-object level of the object. The By Vertex
check box will be activated on selecting Edge, Face, Polygon, or Element sub-object level from
the Selection rollout. The By Vertex check box is used to select all the sub-objects that are
connected to the selected vertex of the object. For example, if you select the Polygon sub-object
level and then select the By Vertex check box. On clicking on a vertex of the object in the
viewport, all the polygons that are connected to the selected vertex will be selected. Select the
Ignore Backfacing check box to select the sub-objects that are facing toward you in the viewports.
Note that you cannot select backfacing sub-objects on selecting this check box.
 

Note
After selecting the By Vertex check box, you can select the sub-objects only by clicking a vertex or
by selecting a portion of the object by dragging a selection box around it.

 
Soft Selection Rollout
This rollout enables you to display a soft selection on an object.

Figure 8-16 The Soft Selection
rollout

The options in this rollout are used to affect the action of movement, rotation, and scaling at sub-
object level of the editable mesh object. To activate this rollout, you need to select a sub-object
level. Next, to activate the other options of this rollout, select the Use Soft Selection check box, as
shown in Figure 8-16. When you select the sub-objects of an object in the viewport, it shows the
falloff in different color combinations. The influence of the colored zone is determined by the value
set in the Falloff spinner. The shape of the falloff is controlled by the value in the Pinch and Bubble
spinners, refer to Figure 8-16.
Edit Geometry Rollout
The options in this rollout are used to edit the geometry at the object as well as sub-object levels.
These options are discussed next.



 
Create: The Create button is used to add the sub-objects to the selected object in the viewport.
This button is available at the Vertex, Face, Polygon, and Element sub-object levels. To add the
sub-objects, select the editable mesh object in the viewport and then choose the Modify tab. Next,
select one of the sub-object levels in the modifier stack and then choose the Create button in the
Edit Geometry rollout. Now, click anywhere in the viewport to add vertices in the selected object
(if the Vertex sub-object level is selected), as shown in Figure 8-17. If you have selected the Face
sub-object level, then click on the three vertices one by one to add a new face, as shown in Figure
8-18.

Figure 8-17 Additional vertices created in a box using the Create button

Figure 8-18 A new face added in a box using the Create button
 

Delete: The Delete button is used to delete the sub-objects in the selected object. To delete a sub-
object, select the editable mesh object in the viewport and choose the Modify tab. Next, select one
of the sub-objects levels in the modifier stack. Now, select the sub-object in the viewport that you
want to delete and choose the Delete button; the selected sub-object will be deleted.
 
Attach: The Attach button is used to attach an object to the selected object in the viewport. To
attach an object, select the editable mesh object in the viewport and choose the Modify tab. Next,
choose the Attach button in the Edit Geometry rollout. Now, when you move the cursor over
another object in the viewport, the attach cursor will be displayed, as shown in Figure 8-19. Click
on the object; it will be attached to the selected object. Also, it will display the same color and
properties as those of the selected object.

Figure 8-19 The attach cursor after choosing the Attach button
 

Attach List: The Attach List button is used to attach a number of objects simultaneously to
selected object. To do so, select the editable mesh object in the viewport and choose the Modify
tab in the Command Panel. Now, choose the Attach List button from the Edit Geometry rollout;



the Attach List dialog box will be displayed, as shown in Figure 8-20.

Figure 8-20 The Attach List dialog box
 
The Attach List dialog box displays a list of all the objects in the viewport. From this list, select the

name of the objects that you want to attach by holding the CTRL or SHIFT key, and then choose the
Attach button; the selected objects in the list will be attached to the object selected in the
viewport. Note that these attached objects will display the same color and properties as that of the
selected object.

 
Detach: The Detach button is used to detach the sub-objects from the selected object to make them
individual objects. This button is available for the Vertex, Face, Polygon, and Element sub-object
levels. To detach a sub-object,

Figure 8-21 The Detach dialog box

select the editable mesh object in the viewport, choose the Modify tab, and then select one of the
sub-object levels in the modifier stack. Next, select the sub-object in the viewport that you want to
detach as an individual object, and then choose the Detach button; the Detach dialog box will be
displayed, as shown in Figure 8-21.

 
In this dialog box, enter the name of the new object in the Detach as text box and then choose the
OK button; the selected sub-object will be detached and treated as an individual object. Now,
when you move the individual object at the object level, it will leave a hole in the original object.
In the Detach dialog box, select the Detach As Clone check box, the selected sub-object will be
copied and treated as individual object. Also, the original object will not get modified.
Break: The Break button is available only for the Vertex sub-object level. It creates a new vertex
for each face attached to the selected vertices. If a vertex is used only by one face, then it will
remain unaffected.
 
Turn: The Turn button is activated only for the Edge sub-object level. It is used to rotate the edges
of an object. Select the editable mesh object in the viewport, choose the Modify tab, and then



select the Edge sub-object level in the modifier stack. Now, choose the Turn button in the Edit
Geometry rollout and select the edges of the object in the viewport one by one; the edges will be
rotated, refer to Figures 8-22 and 8-23.

Figure 8-22 The box before choosing the Turn button

Figure 8-23 The rotated edge of the box after choosing the Turn button
 

Divide: The Divide button is available only for the Edge, Face, Polygon, and Element sub-object
levels. It divides a single face into three smaller faces. If you divide the sub-object at the Polygon
or Element sub-object level, then it will be divided into three faces. To do so, select the editable
mesh object in the viewport, choose the Modify tab, and then select one of the sub-object levels in
the modifier stack except Vertex. Next, choose the Divide button in the Edit Geometry rollout,
and click on the sub-object in the viewport; the sub-object will be divided into three faces, refer to
Figures 8-24 and 8-25.

Figure 8-24 The face before choosing the Divide button

Figure 8-25 The face divided after using the Divide button
 

Extrude: The Extrude button is available for the Edge, Face, Polygon, and Element sub-object
levels. It is used to extrude the sub-objects either by dragging the cursor or by entering the value in
the spinner. To do so, select the editable mesh object in the viewport, choose the Modify tab, and
then select one of the sub-object levels in the modifier stack, except Vertex. Next, select the sub-
object in the viewport and choose the Extrude button to activate it. Now, move the cursor over the
selected sub-object; the extrude cursor will be displayed, as shown in Figure 8-26. Next, press and
hold the left mouse button and move the cursor up or down for the extrusion; the value for the
extrusion will be displayed in the spinner on the right of the Extrude button. You can enter the
value directly in this spinner to extrude the selected sub-object, refer to Figure 8-27.



Figure 8-26 The extrude cursor displayed over the selected polygon

Figure 8-27 The selected polygon sub-object after extrusion
 

Note
To extrude multiple sub-objects simultaneously, select sub-objects by holding the CTRL key, and
then execute the Extrude command. You can also enter a negative value in the Extrude spinner for
negative extrusion, refer to Figure 8-28.

Figure 8-28 The selected polygon after negative extrusion
 

Bevel: The Bevel button is available only for the Face, Polygon, and Element sub-object levels. It
is used to extrude and bevel an object. This button can perform the extrude and bevel functions at
the same time. You can bevel the sub-objects either by dragging the cursor or by entering the value
in the spinner on the right side of the Bevel button. To do so, select the editable mesh object in the
viewport. Choose the Modify tab, and then select one of the sub-object levels in the modifier stack,
except Vertex and Edge. Next, select the sub-object in the viewport and then choose the Bevel
button. Next, move the cursor over the selected sub-object; the bevel cursor will be displayed, as
shown in Figure 8-29. Now, press and hold the left mouse button and move the cursor up or down
to extrude the sub-object, as shown in Figure 8-30.

Figure 8-29 The bevel cursor displayed over the selected polygon



Figure 8-30 The polygon extruded
 

To bevel the sub-object, release the left mouse button and then move the cursor up or down again to
change the shape of the sub-object, as shown in Figures 8-31 and 8-32.

Figure 8-31 The reduced size of the extruded polygon using the Bevel button

Figure 8-32 The increased size of the extruded polygon using the Bevel button

 
Chamfer: The Chamfer button is available only for the Vertex and Edge sub-object levels. It is
used to cut the corners of the sub-object at an angle of 45-degree. You can chamfer the sub-objects
either by dragging the cursor or by entering the value in the spinner on the right side of the Chamfer
button. To do so, select the editable mesh object in the viewport, choose the Modify tab, and then
select the sub-object level in the modifier stack. Next, select the sub-object in the viewport, choose
the

Figure 8-33 The chamfer cursor displayed over the selected vertex

Chamfer button, and move the cursor over the selected sub-object; the chamfer cursor will be
displayed, as shown in Figure 8-33. Next, press and hold the left mouse button, move the cursor up
to chamfer, and release the left mouse button; the sub-object will be chamfered at an angle of 45-
degree, refer to Figures 8-34 and 8-35. As you move the cursor, the chamfer value will be
displayed in the spinner on the right side of the Chamfer button. You can also enter the value
directly in this spinner to chamfer the selected sub-object.

Figure 8-34 The vertex sub-object chamfered using the Chamfer button



Figure 8-35 The edge sub-object chamfered using the Chamfer button
 
Slice Plane and Slice: The Slice Plane and Slice buttons are used to slice the sub-objects to create
new vertices, faces, edges, polygons, and elements. To do so, select the editable mesh object in the
viewport, choose the Modify tab and then select the sub-object level in the modifier stack. Next,
select one or more sub-objects in the viewport and then choose the Slice Plane button; a yellow
colored slice plane gizmo will be displayed in the viewport, as shown in Figure 8-36. Set the
position of the slice plane gizmo over the selected sub-objects by moving or rotating it at the
position where you want to slice them. Then, choose the Slice button; the selected sub-objects will
be divided to create new sub-objects, as shown in Figure 8-37.

Figure 8-36 The slice plane gizmo displayed in the selected object

Figure 8-37 The selected object sliced after choosing the Slice button
 

Cut: The Cut button is available only for the Edge, Face, Polygon, and Element sub-object
levels. It is used to cut the edge, face, polygon, or element of an object to create new vertices,
edges, and faces. To do so, select the editable mesh object in the viewport. Choose the Modify tab,
and then select any sub-object level in the modifier stack, except Vertex. Next, choose the Cut
button and move the cursor over the object; the cursor will change when it comes over any sub-
object. Next, click on the sub-object to specify the first cut point and drag the mouse to specify the
endpoint of the cut; a dotted line will be displayed, as shown in Figure 8-38. Now, click again to
cut the sub-object and right-click to end the cut command; the object will be cut, refer to Figure 8-
39. You can also select the sub-object to be cut at a particular area, as shown in Figure 8-40.

Figure 8-38 The dotted lines



Figure 8-39 The cut on the object after using the Cut button
 

Figure 8-40 The cut on the selected polygon
 

Note
While using the Cut button, select the Ignore Backfacing check box to avoid the cut on the back
face of the sub-object.
 

Weld Area: The options in the Weld area are available only at the Vertex sub-object level. It is
used to weld or join the vertices of the object. The Selected button in the Weld area is used to
weld the selected vertices. To perform the weld operation, select the editable mesh object in the
viewport. Choose the Modify tab, and then select the Vertex sub-object level in the modifier stack;
all the vertices of the object will be displayed in the viewport. By using the rectangular marquee
selection, select the vertices of the object which you need to weld together, refer to Figure 8-41.
Now, set the value in the spinner located on the right side of the Selected button to define the weld
threshold area. All the vertices that you want to weld together must be inside this area. Choose the
Selected button; the vertices will be welded together, refer to Figure 8-42. If the vertices are not
within the weld threshold area whose value you have defined in the spinner, the Weld message box
will be displayed, as shown in Figure 8-43, warning you that there is no vertex in the weld
threshold area. Therefore, you need to increase the threshold area by modifying the value in the
spinner, and then choose the Selected button again to weld the vertices.

Figure 8-41 The selection box around the vertices to be welded

Figure 8-42 The vertices welded together
 

The Target button in the Weld area is used to weld the selected vertices to the unselected target
vertex. To do so, select the editable mesh object in the viewport and choose the Modify tab. Now,



select the Vertex sub-object level in the modifier stack; all vertices of the object will be displayed
in the viewport. Next, select the vertices of the object in the viewport by dragging a selection box
around them,refer to Figure 8-44. Then, choose the Target button and move the vertices toward the
unselected target vertex to which you want to weld the selected vertices. As you bring the selected
vertices over the unselected target vertex, the cursor will convert into a plus sign. Release the
mouse button; the vertices will be welded to the target vertex, as shown in Figure 8-45.

Figure 8-44 The vertices selected for welding

Figure 8-43 The Weld message box

Figure 8-45 The selected vertices welded to the target vertex
 
Modifying Editable Mesh Objects Using Sub-object Levels
To get the advance level modeling of the objects, you need to convert the object into editable mesh
object, which provides you the sub-object levels of an object as discussed earlier in this chapter. To
view the sub-object levels, you need to click on the plus sign on the left side of the Editable Mesh in
the modifier stack. By using these sub-object levels, you can select the sub-objects in the viewport
and modify the object in different ways.

 
On selecting one of the sub-object levels in the modifier stack, it will be activated and turns yellow.
You can select a sub-object by clicking on it in the viewport. To select more than one sub-object
simultaneously, hold the CTRL key, and select them one by one. Alternatively, you can drag a
selection box around the sub-objects to select them simultaneously; they will turn red. After selecting
the sub-objects, you can modify them using the following options:

1. You can move, rotate, and scale the selected sub-objects using the Select and Move, Select and
Rotate, and Select and Uniform Scale tools, respectively from the Main Toolbar.
 

2. You can use different options in the Edit Geometry rollout, as described earlier in this chapter.
 

3. You can use different modifiers from the Modifier List drop-down list.



 
Converting Objects into Editable Poly
To modify an object with editable poly is same as modifying an object with the editable mesh. The
only difference is that the editable poly works with the advance tools meant for polygonal mesh
editing. To work with editable poly, convert the object into editable poly. To do so, you need to use
one of the following methods:
 
1. Create an object and select it in the viewport. Next, right-click on the object; a quad menu will be

displayed. Choose the Convert To: option; a cascading menu will be displayed. Choose the
Convert to Editable Poly option from the cascading menu; the object will be converted into
editable poly.

2. Create an object and select it in the viewport. Choose the Modify tab in the Command Panel; the
modifier stack will be displayed in the Modify panel. In the modifier stack, right-click on the name
of the tool which you have used to create the object; a shortcut menu will be displayed. Choose the
Editable Poly option; the object will be converted into editable poly.

 
3. Create an object and select it in the viewport. Next, move the cursor over the Polygon Modeling

panel in the Graphite Modeling Ribbon; a flyout will be displayed, as shown in Figure 8-46.
Choose the Convert to Poly option; the selected object will be converted into editable poly.

 

Note
When you convert an object into editable poly, various panels will be displayed in the Graphite
Modeling Tools tab such as Edit, Geometry (All), Subdivision, and so on. You will learn about
these panels in the later chapters.

Figure 8-46 Flyout displayed after moving the cursor over the Polygon Modeling panel
 

Note
After an object is converted into an editable poly using any of the above method , it cannot be
modified using the creation parameters rollouts such as the Parameters rollout. So, it is
recommended to set the parameters of an object before converting it into an editable poly.
 
You need to use the following method to set the parameters of an object even after converting it into

an editable poly.
 



4. Create an object and select it in the modifier stack. Next, click on the Modifier List drop-down list
and select Edit Poly from it; the Edit Poly modifier is applied to the object.

 

Note
When you convert an object into an editable poly using the fourth method, some of the rollouts
and/or options are not available.
 
Modifying Editable Poly Objects Using Sub-object Levels
On converting an object into an editable poly, the name of the tool in the modifier stack will be
replaced by Editable Poly, which is known as the object level. Click on the plus sign on the left side
of Editable Poly to view the sub-object levels such as Vertex, Edge, Border, Polygon, and
Element, refer to Figure 8-47. Various rollouts will also be displayed below the modifier stack such
as Selection, Soft Selection, Edit Geometry, Subdivision Surface, Subdivision Displacement, and
Paint Deformation, as shown in Figure 8-47. Other rollouts such as Edit Vertices, Vertex
Properties, Edit Edges, Edit Borders, Edit Polygons, Polygon: Material IDs, Polygon:
Smoothing groups, Polygon: Vertex Colors, and Edit Elements will also be displayed, depending
on the selection of the sub-object level.

Figure 8-47 The sub-object
levels displayed

 
To modify the object using the sub-object levels, select one of the sub-object levels in the modifier
stack; it is activated and turns yellow. Now, select the sub-object by clicking on it in the viewport. To
select more than one sub-object at a time, hold the CTRL key and select them one by one.
Alternatively, you can drag a selection box around the sub-objects to select them simultaneously; they
will turn red. After selecting the sub-objects, you can modify them using the following methods:
 
1. You can move, rotate, and scale the selected sub-objects using the Select and Move, Select and

Rotate, and Select and Uniform Scale tools, respectively in the Main Toolbar.
 



2. You can use different modifiers from the Modifier List drop-down list, about which you will learn
in the later chapters.

 
3. You can use various options available in different rollouts of the Modify panel for a particular sub-

object level.
 
4. You can use different tools available in the Graphite Modeling Ribbon, about which you will

learn in later chapters.
 
The sub-object levels and various rollouts in an editable poly object are discussed next.
 
Sub-object Levels
The editable poly objects consists of sub-objects levels. They are the Vertex, Edge, Border,
Polygon, and Element. They do not have the Face sub-object level like the editable mesh. Therefore,
you cannot select the triangular faces in the editable poly object. Additionally, the editable poly has
the Border sub-object level. The Vertex, Edge, Polygon, and Element sub-objects are same as
discussed in the editable mesh object. The Border sub-object is discussed next.
 

Border
The border is a series of edges that forms a ring around a hole in the object, as shown in Figures

8-48 and 8-49.
 

Figure 8-48 The border selected around the hole of the spout of a teapot

Figure 8-49 The maximized view of the border selected around the hole of the spout of a teapot
 
Rollouts
When you convert an object into editable poly, various rollouts will be displayed below the modifier
stack. The number and name of the rollouts depends on the selection of the sub-object level. These
rollouts are used to modify the objects at the sub-object levels and are discussed next.
 

Selection Rollout
In the Selection rollout, there are five buttons, Vertex, Edge, Border, Polygon, and Element, as
shown in Figure 8-50. These buttons are used to select the sub-objects of an object in the viewport



and are the same as described earlier. Choose any button to activate it. It is similar to selecting the
sub-object level in the modifier stack. The other options in this rollout are discussed next.
 
Shrink/Grow: The Shrink and Grow buttons are available for all the sub-object levels in this
rollout. The Shrink button is used to reduce the selection area of the sub-objects in the viewport.
The Grow button is used to increase the selection area of the sub-objects in the viewport. To use
these buttons, select the editable poly object in the viewport, choose the Modify tab, and then
select one of the sub-object levels in the modifier stack. Next, select the sub-objects in the
viewport. Choose the Shrink or Grow button in the Selection rollout; the selection area will
decrease or increase in the viewport, refer to Figures 8-51, 8-52, and 8-53.
 

Figure 8-50 The Selection rollout with the Border sub-object level selected

Figure 8-51 The selection area in the teapot
 

Figure 8-52 The selection area in the teapot decreases after choosing the Shrink button

Figure 8-53 The selection area in the teapot increases after choosing the Grow button
 

Ring: The Ring button is available only for the Edge and Border sub-object levels. It is used to
select all edges and borders of the object that are parallel to the selected edge. To do so, select an
edge of the object in the viewport, as shown in Figure 8-54, and choose the Ring button; all the



edges parallel to the selected edge will be selected, as shown in Figure 8-55.

Figure 8-54 An edge selected in a cylinder

Figure 8-55 The parallel edges selected after choosing the Ring button
 

Loop: The Loop button is available only for the Edge and Border sub-object levels. It is used to
select all the edges or borders of the object that are aligned with the selected edge or border. To
use this button, select an edge or a border of the object in the viewport, as shown in Figure 8-56,
and then choose the Loop button; all edges or borders that are aligned with the selected edge will
be selected, as shown in Figure 8-57.

 

Figure 8-56 The selected edge of the teapot

Figure 8-57 The edges selected after choosing the Loop button
 

Preview Selection Area: This area is used to preview the selection of sub-objects in the viewport
before selecting them. To do so, you need to use the options in the Preview Selection area. By
default, the Off radio button is selected in this area, therefore, the preview will not be visible in
the viewport.
 
The SubObj radio button in this area enables you to preview the selection of the sub-objects at the
current sub-object level only. To do so, select any sub-object level in the Selection rollout. Now,
select the SubObj radio button in the Preview Selection area. Next, move the cursor over the
object; the corresponding sub-object will be highlighted in yellow color in the viewport, as shown
in Figure 8-58. Click on this sub-object; the sub-object will be selected. If you need to select
multiple sub-objects at a time, move the cursor over the object and hold the CTRL key. Now, move
the mouse over the sub-objects that you need to select; they will be highlighted, refer to Figure 8-
59.



Figure 8-58 The selected sub-object
level highlighted

Figure 8-59 More than one polygon highlighted
 

Click on them and release the CTRL key; the highlighted sub-objects will be selected. Similarly, to
deselect a sub-object from the current selection, hold the ALT key, and move the cursor over the
sub-object that you want to deselect; it will be highlighted. Now, click on it; the highlighted sub-
object will be deselected. To deselect more than one sub-object, you need to hold the ALT+CTRL
keys.

The Multi radio button in the Preview Selection area works similar to the SubObj radio button.
Additionally, the Multi radio button enables you to switch among the sub-object levels in the
Modify panel while selecting the sub-object in the viewport. For example, if you move the cursor
over the Polygon sub-object in the viewport, then the polygon of the object will be highlighted.
Click on it; the highlighted polygon will be selected. Also, the Polygon sub-object level will be
activated in the Modify panel. Similarly, if you select an edge, vertex, or element in the viewport,
then the corresponding sub-object level will be activated in the Modify panel. Therefore, you do
not need to manually switch among the sub-object levels.
 
Just below the Preview Selection area, a text line is displayed which provides the information
about the current selection. Also, when you move the cursor over the object to highlight the sub-
objects in the viewport, another text line will be displayed that will provide the information about
the number and name of the highlighted sub-objects.

 
Soft Selection Rollout
The options in this rollout are the same as discussed in the editable mesh.
 
Edit Geometry Rollout
The options in this rollout are used to edit the geometry of an object. Some of the options in this
rollout are discussed next.
 
Repeat Last: The Repeat Last button is used to repeat the recently used command. For example,
if you have applied a command to a polygon of an object, and need to apply the same command
upto the same level to other polygons, then select the other polygons in the viewport and choose the



Repeat Last button; the same command will be applied to the selected polygons, refer to Figures
8-60 and 8-61.

Figure 8-60 The extruded polygon in a cylinder

 

Figure 8-61 The same extrusion on other polygons after choosing the Repeat Last button
 

Constraints: The options in the Constraints area are used to define the existing geometry to
constrain sub-object transformation. There are four radio buttons in this area. They are: None,
Edge, Face, and Normal. By default, the None radio button is selected. As a result, no constraints
will be applied to the existing geometry. The Edge radio button is used to constrain the sub-object
transformation to edge boundaries. The Face radio button is used to constrain the sub-object
transformations to the individual face. The Normal radio button is used to constrain each sub-
object transformations to its normal.
 
Attach: The Attach button is the same as discussed in the editable mesh object. Choose the Attach
List button on the right side of the Attach button to display the Attach List dialog box. The options
in this dialog box are the same as discussed in the editable mesh object.
 
The Create, Detach, Slice Plane, Slice, and Cut buttons are the same as discussed in the editable
mesh object.
 
Reset Plane: The Reset Plane button is used to reset the default position of the slice plane. When
you choose the Slice Plane button, the Reset Plane and Slice buttons gets activated.
 
QuickSlice: The QuickSlice button is used to slice an object or sub-objects very quickly and
easily. To slice an object quickly, choose the QuickSlice button; a quick slice cursor will be
displayed, as shown in Figure 8-62. Click in the viewport to define the first point of the slice plane;
a slice plane will be displayed, refer to Figure 8-62. Move the cursor to define an angle for the
slice and click again to specify the endpoint of the slice; the object will be sliced according to the
slice plane, as shown in Figure 8-63. It affects the slice operation on the entire object. If you need
to slice particular sub-objects, then you need to select them. Next, right-click to end the QuickSlice
command.
 

Note



It is recommended to avoid performing the slice operation in the Perspective viewport.

Figure 8-62 The quick slice cursor and slice plane displayed

Figure 8-63 The box sliced in the Perspective viewport
 

MSmooth
The MSmooth button is used to smoothen the object or sub-objects. To smoothen the object, select
it in the viewport, as shown in Figure 8-64, and then choose the MSmooth button in the Edit
Geometry rollout; the object will be smoothened, as shown in Figure 8-65. Choose the Settings
button on the right of the MSmooth button; the MeshSmooth Selection caddy control will be
displayed in the viewport, as shown in Figure 8-66. Set the value in the Smoothness spinner to
define the smoothness of the object. The value in this spinner varies from 0.0 to 1.0.
 

Figure 8-64 Selecting the cylinder in the viewport

Figure 8-66 The MeshSmooth Selection caddy control

Figure 8-65 The cylinder smoothened after choosing the MSmooth button

 

Note
To view the spinner names in the caddy control, you need to move the cursor over the buttons in it;
the corresponding name will be displayed at the place of the name of the caddy control.

 
Tessellate: The Tessellate button is used to increase the number of edges or faces in an object and
smoothens the object. By default, when you choose the Tessellate button, the number of edges of



the object will increase. To change the settings, choose the Settings button on the right side of the
Tessellate button; the Tessellate Selection caddy control will be displayed in the viewport, as
shown in Figure 8-67. Next, click on the arrow placed on the Edge button; a drop-down list will
be displayed to select the tessellation method, as shown in Figure 8-68. Select the Edge or
the Face option and then choose the Apply and Continue button; the number of edges or faces will
be increased in the object, refer to Figures 8-69, 8-70, and 8-71. If you need to apply the same
settings again, then choose the Apply and Continue button again. To end the command and close the
caddy control, choose the OK button. In case you need to close the caddy control
without applying the settings to the selection, choose the Cancel button.

Figure 8-67 The Tessellate Selection caddy control

Figure 8-68 The drop-down list displayed after clicking on the arrow
 

Figure 8-70 The box after selecting the Edge radio button

Figure 8-69 A box

Figure 8-71 The box after selecting the Face radio button
 

Make Planar: The Make Planar button is used to bring all the vertices of an object in the same
plane. However, if you select other sub-objects in the viewport, then it will enable you to bring all
the selected sub-objects in the same plane. Choose the X, Y, and Z buttons to align the object
according to the local coordinate system.
 
The Hide Selected button is activated for the Vertex, Polygon, or Element sub-object level. It is
used to hide the selected sub-objects in the viewport.



The Unhide All button is activated for the Vertex, Polygon, or Element sub-object level. It is used
to unhide all the hidden sub-objects in the viewport.
The Hide Unselected button is activated for the Vertex, Polygon, or Element sub-object level. It
is used to hide the unselected sub-objects in the viewport.

 
Subdivision Surface Rollout
The options in this rollout are used to apply the subdivision to the object to make it smooth. The
different areas in this rollout are discussed next.
 
Display and Render Areas: The value in the Iterations spinner is used to specify the number of
times the smooth algorithm will be applied to an object. If you select the Iterations check box in
the Render area, then the value in the Iterations spinner of the Display area will show its effect
only in the viewport. Note that when you increase the number of iterations in the spinner, the
number of segments also increases and it takes longer time to display its effect in the viewport as
well as on rendering. Therefore, increase the number of iterations as per your requirement. The
Smoothness spinner is used to add new polygons to all vertices to smoothen object in the viewport
as well as on rendering. The value in this spinner varies from 0.0 to 1.0. If you select the
Smoothness check box in the Render area, then the value in the Smoothness spinner of the
Display area will show the effect only in the viewport.
 
The Iterations and Smoothness spinners in the Render area are used to smoothen the polygon
objects on rendering. To activate them, select the check boxes on the left side of the spinners.
 
Separate By Area: Select the Smoothing Groups check box in this area to stop the creation of
new polygons at edges between faces that are not under the smoothing group. Select the Materials
check box to stop the creation of new polygons at edges between the faces that do not share the
material IDs.
 
Update Options Area: Select the Always radio button in this area to automatically view the output
of the smoothness settings in the viewport as well as on rendering. Select the When Rendering
radio button to view the output of the smoothness settings only at the time of rendering. Select the
Manually radio button to view the output of the smoothness settings only when you choose the
Update button below the Manually radio button. In this case, if you change the settings as per your
requirement, then to update the settings you need to choose the Update button.
 
Paint Deformation Rollout
The options in this rollout are used to deform the surface of an object by pushing or pulling its
vertices using the Push/Pull button, refer to Figure 8-72. At the object level, it affects the vertices
of the entire object, while at the sub-object level, it affects only the selected vertices of the object.
This rollout has three buttons. The Push/Pull button is used to push or pull the vertices of the
object. Choose the Push/Pull button to activate it and move the cursor over the object in the
viewport; a light blue colored brush along with the cursor will be displayed in the viewport, as
shown in Figure 8-73. Press the left mouse button; the brush will turn red. Drag the cursor to



deform the surface of the object, as shown in Figure 8-74, and release the left mouse button; the

Figure 8-72 The Paint Deformation rollout

object will be deformed. At the sub-object level, choose the Push/Pull button to activate it and
move the cursor over the selected sub-objects; a light blue colored brush will be displayed in the
viewport. Now, click on it to deform the surface and right-click to exit the command. While
performing the push/pull command, the object will be pushed or pulled, depending on the value that
you have entered in the Push/Pull Value spinner
 

Figure 8-73 The brush displayed on choosing the Push/Pull button

Figure 8-74 The object deformed at the corner vertex
 

The Relax button is used to maintain the distance between the vertices of the object. The Revert
button is used to erase the effect of the Push/Pull button by clicking on the same vertices or object.
To reverse the effect of the Push/Pull button simultaneously while using it, you need to hold the
CTRL key and click on the same vertex.

 
Push/Pull Direction Area: The radio buttons in this area are used to specify the direction of the
push or pull over the object. If you select the Original Normals radio button, then after pushing or
pulling, the vertices of the object will move in the direction of its normal before deformation. If you
select the Deformed Normals Transform axis radio button, then after pushing or pulling, the
vertices of the object will move in the direction of its normal after deformation. Select the X, Y, or
Z radio button to move the vertices along the direction of the selected radio button.
 
As mentioned earlier, the value in the Push/Pull Value spinner is used to specify the extent of
pushing or pulling the vertices of an object. The positive value enables you to pull the vertices, and



the negative value enables you to push the vertices. The Brush Size spinner is used to specify the
size of the brush cursor in the viewport. The value in the Brush Strength spinner is used to specify
the strength of the brush by which it applies the push or pull effect. It varies from 0.0 to 1.0. Choose
the Brush Options button; the Painter Options dialog box will be displayed. You can set various
parameters of the brush in this dialog box. Choose the Commit button to deform the object
permanently. Note that you cannot use the Revert button after choosing the Commit button. Choose
the Cancel button to erase all the changes that you made to deform the object. However, if you have
already committed the effects, then you cannot use the Cancel button to erase the effects.
 
Edit Vertices Rollout
On selecting the Vertex sub-object level, the Edit Vertices rollout will be displayed in the Modify
panel, as shown in Figure 8-75. The options in this rollout are used to edit the vertices of
an object. To delete the vertices of an object, select them in the viewport and choose
the Remove button; the vertices will be deleted. Alternatively, you can press the DELETE key, but
it will create a hole in the object. The Connect button is used to connect the two selected vertices
by creating an edge between them, refer to Figures 8-76 and 8-77.

Figure 8-75 The Edit Vertices rollout

Figure 8-76 The vertices selected in the object

Figure 8-77 The edge created between the vertices selected
 

Choose the Remove Isolated Vertices button to remove the vertices that are not attached to any
polygon in the object. Choose the Remove Unused Map Verts button to remove the vertices that
cannot be used for mapping. The Weight spinner is used to set the weight of the vertex that
specifies the smoothness towards the vertex in the output. The Break, Extrude, Weld, Chamfer,
and Target Weld buttons are the same as discussed in the editable mesh. Also note that the
Extrude, Weld, and Chamfer buttons have the Settings button on the right side to apply the
selected command more accurately.



Edit Edges Rollout
On selecting the Edge sub-object level, the Edit Edges rollout will be displayed, as shown in
Figure 8-78. The options in this rollout are used to edit the edges of an object.
The Insert Vertex button is used to add a vertex on the edge. To do so, choose the Insert
Vertex button; the vertices of the object will be displayed in the viewport. Now, click on an edge
of the object; a new vertex will be created. Right-click to exit the command. To delete an edge of
the object, select the edge in the viewport, and choose the Remove button; the selected edge will
be deleted. Alternatively, you can press the DELETE key, but it will create a hole in the object.

Figure 8-78 The Edit Edges rollout

The Connect button is used to connect the two selected edges by creating a new edge between
them. Choose the Settings button on the right side of the Connect button; the Connect Edges caddy
control will be displayed in the viewport, as shown in Figure 8-79. It is used to set the parameters
of the additional edge created using the Connect button. The value in the Segments spinner in this
caddy control is used to specify the number of new edges to be created in between the selected
edges. The value in the Pinch spinner is used to set the distance between the new edges. The value
in the Slide spinner specifies the position of the new edges. By default, the new edges are created
at the center.
 
To set the number of segments per chamfer, select an edge of the object in the viewport. Now,
choose the Settings button on the right of the Chamfer button; the Chamfer caddy control will be
displayed in the viewport, as shown in Figure 8-80.

Figure 8-79 The Connect Edges caddy control in the viewport

Figure 8-80 The Chamfer caddy control in the viewport
 

In this caddy control, click on the down arrow of the Chamfer Type button; a flyout will be
displayed with two options, Standard Chamfer and Quad Chamfer, refer to Figure 8-81. The
caddy control displayed on choosing Standard Chamfer from the Chamfer Type flyout is shown



in Figure 8-80. The caddy control displayed on choosing Quad Chamfer from the Chamfer Type
flyout is shown in Figure 8-82.

Figure 8-81 The Chamfer Type flyout

Figure 8-82 The Chamfer caddy control on choosing Quad Chamfer from the flyout
 

Set the value in the Edge Chamfer Amount spinner to specify the amount of chamfering for the
selected edge. Figures 8-83 and 8-84 display the selected edges chamfered with the Standard
Chamfer type and Quad Chamfer type, respectively.

Figure 8-83 Chamfering with the Standard Chamfer type and Edge Chamfer Amount spinner = 2

Figure 8-84 Chamfering with the Quad Chamfer type and Edge Chamfer Amount spinner = 2
 

Note that you need to move the cursor over the buttons to know their respective names.
 
Set the value in the Connect Edge Segments spinner to define the number of segments in the
chamfer. More the number of the segments, more will be the roundness of the chamfer. Figures 8-85
and 8-86 display the selected edges chamfered with the Standard Chamfer type and Quad
Chamfer type, respectively. You will notice that in the Standard Chamfer type, the no of polygons
created are equal to the value in the Connect Edge Segments spinner for each chamfered edge.
However, in the Quad Chamfer type the no of polygons created are double the value in the
Connect Edge Segments spinner for each chamfered edge.



Figure 8-85 Chamfering with the Standard Chamfer type and the Connect
Edge Segments spinner = 2

Figure 8-86 Chamfering with the Quad Chamfer type and the Connect Edge Segments spinner =
2
 

The Edge Tension spinner is activated only for the Quad Chamfer type. It determines the angle
between the new polygons generated by chamfering edges between non-coplanar polygons. Figures
8-87, 8-88, and 8-89 display the chamfered edges with the value 1, 0.5, and 0 in the Edge tension
spinner, respectively.
The lower the value of the Edge Tension spinner, higher will be the angle between the new
polygons generated by chamfering edges between non-coplanar polygons.

 
If you select the Open check box, the polygons which are created by chamfering process will be
deleted, refer to Figure 8-90. The Invert Open spinner located at the right of the Open spinner is
activated only when the Open check box is selected and the Quad Chamfer type is chosen. Select
the Invert Open check box; all the polygons except those created while chamfering will be
deleted, refer to Figure 8-91.

Figure 8-87 Chamfering with the Edge Tension spinner = 1

Figure 8-89 Chamfering with the Edge Tension spinner = 0



Figure 8-88 Chamfering with the Edge Tension spinner = 0.5

Figure 8-90 The deleted faces on selecting the Open check box

Figure 8-91 The remaining polygons after selecting the Invert Open check box
 

 
Click on the down arrow of the Smooth Type button; a flyout will be displayed, as shown in Figure
8-92. Choose the desired option from the flyout and then select the Smooth check box at the left of
the Smooth Type button to smoothen the portion as per the option chosen from the flyout.

Figure 8-92 The flyout displayed
 
 

The value of the Smooth Threshold spinner ranges from 0 to 180. The more the value of the
Smooth Threshold spinner, higher is the smoothness.

 
The Create Shape From Selection button in the Edit Edges rollout is used to create a spline
shape from the selected edges. To do so, select the edges of an object in the viewport and then
choose the Create Shape From Selection button; the Create Shape dialog box will be displayed,



as shown in Figure 8-93. Enter a name in the Curve Name text box for the newly created shape.
Select the Smooth or Linear radio button to create a smooth or a linear curve, respectively. Next,
choose the OK button; a spline will be created along with the selected edges, as shown in Figures
8-94 and 8-95.

Figure 8-93 The Create Shape dialog box

Figure 8-94 The edges selected in the box

Figure 8-95 The spline created after using the Create Shape From Selection button
 

Edit Borders Rollout
On selecting the Border sub-object level, the Edit Borders rollout will be displayed, as shown in
Figure 8-96. The options in this rollout are used to edit the border of an object. The Cap button is
used to create a polygon to cap the selected border of the object. To do so, select the border of the
object in the viewport and then choose the Cap button; a polygon will be displayed to cap the
border, as shown in Figures 8-97 and 8-98. The other options in this rollout are the same as
described earlier in this chapter.

Figure 8-96 The Edit
Borders rollout

 



Figure 8-97 The selected border of the spout of a teapot

Figure 8-98 The cap after choosing the Cap button
 

Edit Polygons Rollout
When you select the Polygon sub-object level, the Edit Polygons rollout will be displayed, as
shown in Figure 8-99. The options in this rollout are used to edit the polygons of the object.
The Outline button is used to increase or decrease the outside edges of theselected polygons, refer
to Figures 8-100 and 8-101. Choose the Settings button on the right of the Outline button;
the Outline caddy control will be displayed in the viewport, refer to Figure 8-101.Set the value in
the Amount spinner to specify the increment or decrement of the outside edge of the
selected polygon. Choose the OK button to apply the function and exit the Outline dialog box.

Figure 8-99 The Edit
Polygons rollout

The Inset button in the Edit Polygons rollout is used to inset the outside edges of the selected
polygons, refer to Figures 8-102 and 8-103. Choose the Settings button on the right of the Inset
button; the Inset caddy control will be displayed in the viewport, as shown in Figure 8-103. Set the
value in the Amount spinner to specify the amount of inset. Next, click on the arrow placed on the
Group button; a drop-down list will be displayed, as shown in Figure 8-104. Select the Group
option to inset the group of polygons. Select the By Polygon option to inset the polygons in the
group individually. Choose the OK button to apply the function and exit the caddy control. The Flip
button in the Edit Polygons rollout is used to flip the direction of the selected polygons.

 
 
 

Figure 8-100 The selected polygons in a sphere



Figure 8-101 The selected polygons after choosing the Outline button
 

Figure 8-102 The group of polygons inset on selecting the Group option

Figure 8-103 The Inset caddy control displayed
 

 

Figure 8-104 The drop-down list displayed in the Inset caddy control
 

The Hinge From Edge button is used to create a hinge on the selected polygon along the edge. To
do so, select a polygon of the object in the viewport and choose the Hinge From Edge button.
Now, move the cursor on an edge of the selected polygon, as shown in Figure 8-105, and drag the
cursor in the vertical direction; the hinge will be created, as shown in Figure 8-106.
 

Figure 8-105 The polygon selected in the box



Figure 8-106 The hinge created on choosing the Hinge From Edge button
 

You can also create a hinge on the polygon using the Settings button on the right side of the Hinge
From Edge button. To do so, select a polygon of the object in the viewport and choose the Settings
button; the Hinge From Edge caddy control will be displayed in the viewport, as shown in Figure
8-107. The value in the Angle spinner is used to specify the angle of rotation. You can set a
positive or a negative value in this spinner. The Segments spinner is used to specify the number of
segments in the selected polygon. Choose the Pick Hinge button to activate it and click on an edge
of the selected polygon in the viewport; the hinge will be created. Choose the OK button to close
the caddy control.

 
The Extrude Along Spline button in the Edit Polygons rollout is used to extrude the polygons of an
object along the spline in the viewport. To do so, select a polygon of the editable poly object in the
viewport. Now, choose the Settings button on the right side of the Extrude Along Spline button;
the Extrude Along Spline caddy control will be displayed in the viewport, as shown in Figure 8-
108. Choose the Pick Spline button in the caddy control to activate it and then select the spline in
the viewport, as shown in Figure 8-109; the selected polygon will be extruded along the spline, as
shown in Figure 8-110. Set the parameters of the extruded spline using the options in the Extrude
Polygons Along Spline caddy control.

Figure 8-107 The Hinge From Edge caddy control

Figure 8-108 The Extrude Along Spline caddy control
 

Figure 8-109 The polygon selected in the plane and the spline



Figure 8-110 The selected polygon extruded along the spline
 
TUTORIALS
Tutorial 1
In this tutorial, you will create a golf ball, as shown in Figure 8-111, by modifying the standard
primitives at advanced level. (Expected time: 20 min)

Figure 8-111 A golf ball model
 
The following steps are required to complete this tutorial:
 
a. Create the project folder.
b. Create a golf ball.
c. Convert the golf ball.
d. Modify the golf ball.
e. Save and render the scene.
 
Creating the Project Folder
Create a new project folder with the name c08_tut1 at \Documents\3dsmax2015 and then save the
file with the name c08tut1, as discussed in Tutorial 1 of Chapter 2.
 
Creating a Golf Ball
In this section, you will create a golf ball by using the Geosphere tool.
 
1. Activate the Top viewport and choose Create > Geometry in the Command Panel; the Standard

Primitives option is displayed by default in the drop-down list below the Geometry button. Now,
choose the GeoSphere tool from the Object Type rollout.

 
2. Expand the Keyboard Entry rollout and set the value 130.0 in the Radius spinner. Next, choose

the Create button; a geosphere is created in viewports.
 
3. In the Parameters rollout, set the value 8 in the Segments spinner.



 
4. Choose the Zoom Extents All tool to display the geosphere in viewports, as shown in Figure 8-

112.

Figure 8-112 The geosphere displayed in viewports
 
5. In the Name and Color rollout, enter golf ball; the geosphere is named as golf ball.
 
6. Use the color swatch to change the color of golf ball to white.

 
Next, you need to convert golf ball into an editable mesh and modify it using the sub-object levels.
 
Converting the Golf Ball into an Editable Mesh
In this section, you will convert golf ball into an editable mesh.
 
1. Select golf ball in any viewport and right-click on it; a quad menu is displayed. Choose the

Convert To option; a cascading menu is displayed. Choose Convert to Editable Mesh; the golf
ball is converted into editable mesh.

 

Note
When you convert the golf ball into editable mesh, the GeoSphere label in the modifier stack gets
replaced by the Editable Mesh.
 
Next, you need to modify golf ball using the sub-object levels in the modifier stack to give it a perfect

shape.
 
Modifying the Golf Ball Using the Sub-object Levels
In this section, you will modify golf ball to give it a perfect shape.
 
1. Activate the Perspective viewport. Choose the Zoom tool and zoom in the Perspective viewport to

view golf ball, as shown in Figure 8-113.



Figure 8-113 The golf ball geometry zoomed in the Perspective viewport
 

2. Choose the Maximize Viewport Toggle tool to maximize the Perspective viewport. 

3. Make sure that golf ball is selected in the Perspective viewport. In the modifier stack, click on the
plus sign on the left of the Editable Mesh to view all the sub-object levels.

 
4. Select the Polygon sub-object level; it turns yellow and gets activated.
 
5. Press the CTRL+A keys to select all the polygons of golf ball, as shown in Figure 8-114.

Figure 8-114 All polygons in the golf ball selected
 
6. Select the Edge sub-object level in the modifier stack.
 
7. Press the CTRL+A keys to select all the edges of golf ball, as shown in Figure 8-115.

Figure 8-115 All edges of golf ball selected
 
 
Now, if you select the Polygon sub-object level in the modifier stack, all the polygons of golf ball

will be selected in the viewport. And, if you select the Edge sub-object level, then all the edges of
golf ball will be selected in the viewport.

 
8. In the Edit Geometry rollout, set the value of the Chamfer spinner to 5 and press ENTER; all the

selected edges of golf ball are chamfered and hexagonal polygons are created, as shown in Figure
8-116.



 

Note
After entering a value in the Chamfer spinner and pressing the ENTER key, the value in the
spinners changes to 0 automatically.
 
9. Now, in the modifier stack, select the Polygon sub-object level; all the polygons of golf ball get

selected except the new hexagonal polygons, as shown in Figure 8-117.
 
Next, you need to select all new hexagonal polygons of golf ball.

Figure 8-116 All edges of golf ball chamfered

Figure 8-117 All polygons in golf ball, except new hexagonal polygons selected
 
10. Choose the Select Invert option from the Edit menu; all the new hexagonal polygons of golf ball

are selected in the viewport, as shown in Figure 8-118.
 
11. In the Edit Geometry rollout, set -1 in the Extrude spinner for the negative extrusion of the

selected hexagonal polygons and press ENTER, refer to Figure 8-119.

Figure 8-118 All hexagonal polygons of golf ball selected in the viewport

Figure 8-119 Hexagonal polygons displayed after negative extrusion
 
12. Enter -4 in the Bevel spinner of the Edit Geometry rollout to bevel the selected hexagonal



polygons and then press ENTER.
 
Now, you need to smoothen the selected polygons of golf ball.

13. Select the MeshSmooth modifier from the Modifier List drop-down list at the top of the modifier
stack in the Modify panel. Use the default settings for the MeshSmooth modifier; the golf ball is
smoothened, refer to Figure 8-120.

 
14. Click anywhere in the viewport to deselect the sub-objects. Press the F4 key; golf ball is

displayed in the viewport.
 
15. Choose the Maximize Viewport Toggle tool to view golf ball in viewports.
 
Saving and Rendering the Scene
In this section, you will save the scene and then render it. You can also view the final rendered image
of this model by downloading the c08_3dsmax_2015_rndr.zip file from www.cadcim.com. The path
of the file is as follows: Textbooks > Animation and Visual Effects > 3ds Max > Autodesk 3ds Max
2015: A Comprehensive Guide
 
1. Change the background color of the scene to white, as discussed in Tutorial 1 of Chapter 2. Next,

choose Save from the Application menu.
 
2. Activate the Perspective viewport. Next, choose Save from the Application menu.
 
3. Choose the Render Production tool from the Main Toolbar; the Rendered Frame window is

displayed. This window shows the final output of golf ball, as shown in Figure 8-121.
 

4. Close this window.

Figure 8-120 The golf ball geometry after applying the Mesh Smooth modifier

Figure 8-121 The final output
after rendering

 



 
Tutorial 2
In this tutorial, you will create the model of an LCD monitor, as shown in Figures 8-122 and 8-123,
by modifying 3D mesh objects at advanced level. (Expected time: 30 min)
 

Figure 8-122 The model of an LCD monitor (view 1)

Figure 8-123 The model of an LCD monitor (view 2)
 

The following steps are required to complete this tutorial:
 
a. Create the project folder.
b. Create the front portion of monitor.
c. Create the back portion of monitor.
d. Create speakers.
e. Create buttons.
f. Create the support of monitor.
g. Save and render the scene.
 
Creating the Project Folder
Create a new project folder with the name c08_tut2 at \Documents\3dsmax2015 and then save the
file with the name c08tut2, as discussed in Tutorial 1 of Chapter 2.
 
Creating the Front Portion of Monitor
In this section, you will create the front portion of the LCD monitor.
 
1. Activate the Front viewport and choose Create > Geometry in the Command Panel. In this panel,

by default the Standard Primitives option is displayed in the drop-down list below the Geometry
button. Now, choose the Box tool from the Object Type rollout.

 
2. Expand the Keyboard Entry rollout and set the following values in their respective spinners:
 



Length: 86 Width: 128 Height: 3.0
 
3. Choose the Create button; a box is displayed in the viewports.
 
4. In the Parameters rollout, set the values as follows:
Length Segs: 12 Width Segs: 15 Height Segs: 1

5. Choose the Zoom Extents All tool; a box is displayed in all the viewports, as shown in Figure 8-
124.

Figure 8-124 The box for the front portion of the monitor displayed in viewports
 
6. In the Name and Color rollout, enter front portion; the box is named as front portion. Also,

change the color of front portion to white.
 
Next, you need to convert front portion into an editable poly to modify it using sub-object levels.
 
7. Select front portion in any viewport and right-click on it; a quad menu is displayed. Choose the

Convert To: option; a cascading menu is displayed. Choose Convert to Editable Poly; front
portion is converted into an editable poly.

 
When you convert front portion into an editable poly, the name of the Box tool in the modifier stack

gets replaced with Editable Poly. Next, you need to modify front portion using sub-object levels in
the modifier stack to give it a shape similar to the front portion of the monitor.

 
8. Activate the Front viewport and choose the Maximize Viewport Toggle tool to maximize it.
 
9. Make sure that front portion is selected in the viewport. In the modifier stack, click on the plus

sign on the left of the Editable Poly to view all the sub-object levels.
 
10. Select the Polygon sub-object; it turns yellow and gets activated.
 
11. In the Selection rollout, select the Ignore Backfacing check box, refer to Figure 8-125.



12. In the Front viewport, hold the CTRL key and select all polygons of front portion, except the
outer rows, refer to Figure 8-126.

F

igure 8-125 The Ignore Backfacing check box selected

Figure 8-126 All polygons selected in the Front viewport
 

Note
You can also use the Grow button in the Selection rollout to increase the selection area of
polygons in the viewport.
 
13. In the Edit Polygons rollout, choose the Settings button on the right side of the Extrude button to

extrude the selected polygons; the Extrude Polygons caddy control is displayed in the viewport, as
shown in Figure 8-127. In the Height spinner, set the value -3 for negative extrusion and choose
OK twice to close the caddy control.

 
14. Click on the Polygon sub-object level in the modifier stack to deactivate it. Next, click anywhere

in the viewport to deselect front portion.
 
15. Choose the Maximize Viewport Toggle tool to view all the four viewports simultaneously. The

extrusion effect is displayed in the Perspective viewport, as shown in Figure 8-128.

Figure 8-127 The Extrude Polygons caddy
control



Figure 8-128 The extrusion effect displayed in the Perspective viewport
 
Now, you need to create a box for the screen of front portion.
 
16. Activate the Front viewport, choose Create > Geometry from the Command Panel. In this

panel, the Standard Primitives option is displayed by default in the drop-down list below the
Geometry button. Now, choose the Box tool from the Object Type rollout.

 
17. Expand the Keyboard Entry rollout and set the following values in their respective spinners:
 
Length: 72 Width: 110.5 Height: 0.5
 
18. Choose the Create button; a box is displayed in viewports.
 
19. In the Parameters rollout, set the values as follows:

Length Segs: 5 Width Segs: 5 Height Segs: 5
 
20. In the Name and Color rollout, enter screen; the box is named as screen. Change the color of

screen to black. Figure 8-129 shows screen in the viewports.
 
21. Group screen and front portion as discussed earlier and name it as front part.
 

Figure 8-129 The screen geometry in the viewports
 

Creating the Back Portion of Monitor
In this section, you will create the back portion of the monitor.
 
1. Activate the Front viewport, choose Create > Geometry from the Command Panel. Now, choose

the Box tool from the Object Type rollout.

2. Expand the Keyboard Entry rollout and set the following values in their respective spinners:



 
Length: 86 Width: 128 Height: 5.0
 
3. Choose the Create button; a box is displayed in viewports.
 
4. In the Parameters rollout, set the values as follows:

Length Segs: 12 Width Segs: 15 Height Segs: 1
 
5. In the Name and Color rollout, enter back portion and press ENTER; the box is named as back

portion. Now, change the color of back portion to black.
 
6. Activate the Left viewport and align back portion with the back of front part, as shown in Figure

8-130.

Figure 8-130 Alignment of the back portion with the front part in the Left viewport
 

7. Convert back portion into editable poly to modify it at an advanced level as discussed earlier.
 
8. Activate the Front viewport and make sure back portion is selected. Now, right-click on back

portion; a quad menu is displayed. Choose the Hide Unselected option from the quad menu; front
part is hidden in the viewport and only back portion is displayed in all the viewports. This will
help you to modify back portion easily.

 
Next, you need to modify the back side of back portion. To do so, you need to change the Front

viewport to the Back viewport so that you can view the back side of the object.
 
9. Click on the Front label in the Front viewport; a flyout is displayed showing various options to

display different views of the viewport, as shown in Figure 8-131. Choose the Back option; the
Back viewport is displayed.

 
10. In the modifier stack, click on the plus sign on the left of Editable Poly to view all the sub-object

levels.
 
Tip: To perform precise modeling at an advanced level, you can invoke the Maximize Viewport
Toggle tool.
 
11. Select the Polygon sub-object level; it turns yellow and gets activated.



 
12. In the Back viewport, hold the CTRL key and select the outer polygons of back portion, as shown

in Figure 8-132.

Figure 8-131 A flyout showing various options to display views
 

Figure 8-132 The outer polygons selected in back portion
 

13. Right-click on the Select and Uniform Scale tool from the Main Toolbar; the Scale Transform
Type-In dialog box is displayed. In the Offset: Screen area, set the value 90 in the % spinner and
press ENTER; the selected polygons are uniformly scaled to 90 percent, as shown in Figure 8-133.
Next, close this dialog box.

 
14. Click anywhere in the viewport to deselect polygons.
 
15. In the Selection rollout, select the Ignore Backfacing check box. Next, choose the Select Object

tool and select the inner polygons by using the rectangukar cross selection, as shown in Figure 8-
134.

Figure 8-133 The selected polygons uniformly scaled in back portion



Figure 8-134 Selecting the inner polygons in back portion
 
16. Right-click on the Select and Uniform Scale tool from the Main Toolbar; the Scale Transform

Type-In dialog box is displayed. In the Offset: Screen area, set the value 90 in the % spinner and
press ENTER; the selected polygons are uniformly scaled to 90 percent, as shown in Figure 8-135.
Next, close this dialog box.

 
17. Activate the Left viewport and make sure that the polygons are still selected. Choose the Select

and Move tool and right-click on it; the Move Transform Type-In dialog box is displayed. In the
Offset: Screen area, enter -7 in the X spinner and press ENTER; the selected polygons move in
the horizontal direction, as shown in Figure 8-136. Next, close this dialog box.

 

Figure 8-135 The selected polygons uniformly scaled to 90 percent

Figure 8-136 Selected polygons dragged horizontally
 
18. Select the Polygon sub-object level in the modifier stack to deactivate it. Next, click anywhere in

the viewport to deselect the object in the viewport.
 

Note
While working in the Back or Left viewport, you can view the output of the modification in the
Perspective viewport using the Orbit tool.
 
19. Change the Back viewport to Front viewport as described earlier. Now, right-click in the

viewport; a quad menu is displayed. Choose the Unhide All option; all objects are displayed in the
viewports.

 
20. Select back portion and front part in any viewport simultaneously by dragging a selection box

around them and group them as monitor.



 
Creating Speaker for the Monitor
In this section, you will create speaker for the monitor.
 
1. Activate the Front viewport and choose Create > Geometry from the Command Panel. By

default, the Standard Primitives option is displayed in the drop-down list below the Geometry
button. Now, choose the Box tool from the Object Type rollout.

 
2. Expand the Keyboard Entry rollout and set the following values in their respective spinners:
 
Length: 7.0 Width: 128 Height: 0.2
 
3. Choose the Create button; a box is displayed in the viewports.
 
4. In the Parameters rollout, make sure the value in the Length Segs and Width Segs spinner is 15

and in the Height Segs spinner is 1.
 
5. In the Name and Color rollout, enter speaker; the box is named as speaker. Also, change the color

of speaker to black.
 
6. Align speaker in viewports with monitor, as shown in Figure 8-137.
 
You need to apply the Lattice modifier to speaker from the Modifier List drop-down list located at

the top of modifier stack.
 
7. Make sure that speaker is selected in the viewport. Next, choose the Modify tab in the Command

Panel and then select the Lattice modifier from the Modifier List drop-down list; the Lattice
modifier is displayed in the modifier stack.

 
8. In the Parameters rollout of the Lattice modifier, select the Struts Only from Edges radio button.

In the Struts area, set the value 0.5 in the Radius spinner. Also, select the Smooth check box.
 
9. Click anywhere in the viewport to deselect speaker and choose the Zoom Extents All tool to view

all objects in all the viewports.
 



Figure 8-137 Alignment of the speaker with the monitor in viewports
 

Creating Buttons
In this section, you will create buttons for the monitor by using the ChamferCyl tool.
 
1. Activate the Front viewport and choose Create > Geometry in the Command Panel. Now, select

Extended Primitives from the drop-down list below the Geometry button and choose the
ChamferCyl tool from the Object Type rollout.

 
2. Expand the Keyboard Entry rollout and set the values as follows:
 
Radius: 1.5 Height: 1.0 Fillet: 0.5
 
3. Choose the Create button; a chamfer cylinder is displayed in the viewports.
 
4. In the Name and Color rollout, enter b01; the chamfer cylinder is named as b01. Also, change the

color of the b01 to black.
 
5. Align b01 in viewports with front portion, as shown in Figure 8-138. You need to choose the

Zoom or Zoom Region tool to align it properly.
 
6. In the Front viewport, create five copies of b01. They are automatically named as b002, b003,

b004, b005, and b006. Next, align them in the viewports, as shown in Figure 8-139.
 
7. Select all the objects in the viewport and group them as LCD Monitor.
 
8. Activate the Left viewport and select LCD Monitor. Now, right-click on the Select and Rotate

tool from the Main Toolbar; the Rotate Transform Type-In dialog box is displayed. In the
Offset: Screen area, set the value 15 in the Z spinner and press the ENTER key.

Next, close this dialog box; LCD Monitor is displayed in the viewports, as shown in Figures 8-140
and 8-141.



Figure 8-138 Alignment of b01 with front portion in viewports
 

Figure 8-139 Alignment of b002, b003, b004, b005, and b006 in viewports
 

Figure 8-140 The LCD monitor group displayed after rotating it in the Left viewport

Figure 8-141 The LCD monitor group displayed in the Perspective viewport
 
Creating the Support of Monitor
In this section, you will create support of monitor by using the ChamferCyl tool
 
1. Activate the Top viewport and choose Create > Geometry in the Command Panel. Next, select

Extended Primitives from the drop-down list below the Geometry button, and then choose the
ChamferCyl tool from the Object Type rollout.

 
2. Expand the Keyboard Entry rollout and set the following values in their respective spinners:
 



Radius: 23.698 Height: 6.091 Fillet: 2.284
 
3. Choose the Create button from the Command Panel; a chamfer cylinder is displayed in viewports.
 
4. In the Parameters rollout, set the values as follows:
 
Fillet Segs: 5 Sides: 18 Cap Segs: 4
 
5. In the Name and Color rollout, enter support; the chamfer cylinder is named as support. Also, use

the color swatch to change the color of support using the following values:
Red: 115 Green: 115 Blue: 115
 
6. In the Left viewport, move the cursor over the Y axis and move support below LCD monitor.

Also, move support in the horizontal direction, as shown in Figure 8-142.
 

7. Make sure that support is selected. Next, choose the Zoom Extents All Selected tool; support is
zoomed in the viewports, as shown in Figure 8-143.

Figure 8-142 The support geometry moved in the Left viewport
 

Figure 8-143 The support geometry zoomed in viewports
 
8. Convert support into editable poly to modify it to an advanced level.

 
9. In the modifier stack, click on the plus sign on the left of Editable Poly to view all the sub-object

levels.
 
10. Select the Polygon sub-object level; it turns yellow and gets activated.



 
11. Press and hold the CTRL key and select the inner polygons of support in the Top viewport, as

shown in Figure 8-144.
 

Figure 8-144 The inner polygons of support selected
 

12. In the Edit Polygons rollout, choose the Settings button on the right of the Extrude button; the
Extrude Polygons caddy control is displayed in the viewport. Set the value 2.0 in the Height
spinner, refer to Figure 8-145, and choose the OK button twice to close this caddy control.

 
13. Choose the Settings button on the right of the Bevel button; the Bevel caddy control is displayed

in the viewport. Set the value 1.0 in the Height spinner, refer to Figure 8-146, press ENTER, and
choose OK twice to close the caddy control; the support is displayed in viewport. Figures 8-147
and 8-148 shows the support displayed in the Top and Perspective viewports, respectively.

Figure 8-145 The Extrude Polygons caddy control

Figure 8-146 The value set in the Height spinner of the Bevel caddy control
 

Figure 8-147 The selected polygons in the Top viewport after extruding and beveling



Figure 8-148 The selected polygons in the Perspective viewport after extruding and beveling
 
14. Select the Polygon sub-object level in the modifier stack to deselect it and then click anywhere in

the viewport to deselect the object.
 
15. Choose the Zoom Extents All tool and align support in viewports, as shown in Figure 8-149.

Figure 8-149 Alignment of support in viewports
 
16. Select support and choose the Zoom Extents All Selected tool. Now, select the Polygon sub-

object level in the modifier stack; all the selected polygons are displayed.
 
17. Activate the Perspective viewport and set the view using the Zoom, Select and Move and Orbit

tools, as shown in Figure 8-150. Next by holding the ALT key, deselect the polygons except the five
polygons on the back, refer to Figure 8-151.

Figure 8-150 The view of the Perspective viewport after using the Zoom and Orbit tools



Figure 8-151 The polygons selected in the Perspective viewport
 
18. Select the Polygon sub-object level in the modifier stack to deactivate it and then click anywhere

in the viewport to deselect the object.
 
19. Choose the Zoom Extents All tool and set the view of the Perspective viewport to view the back

side of LCD monitor, as shown in Figure 8-152.
 

20. Activate the Left viewport and select support from it. Next, select the Polygon sub-object level;
all the selected polygons are highlighted.

 
21. In the Edit Polygons rollout, choose the Settings button on the right of the Extrude button; the

Extrude Polygons caddy control is displayed. Set the value 29 in the Height spinner, press
ENTER and choose OK twice to close this caddy control; the selected polygons are extruded and
displayed in the Left viewport, as shown in Figure 8-153.

Figure 8-152 The back side geometry of LCD monitor in the Perspective viewport

Figure 8-153 The selected polygons extruded in the Left viewport
 
22. In the Left viewport, move the cursor over the horizontal axis and drag the selected polygons

horizontally toward the right side until they touch LCD monitor, as shown in Figure 8-154.
 
23. In the Edit Polygons rollout, again choose the Settings button on the right of the Extrude button;

the Extrude Polygons caddy control is displayed. Set the value 19 in the Height spinner and press
ENTER. Next, choose OK twice to close this caddy control. The support is extruded in the Left
viewport, as shown in Figure 8-155.

Figure 8-154 The support geometry in the Left viewport after moving it horizontally



Figure 8-155 The support geometry in the Left viewport after extrusion
 
24. In the Left viewport, move the cursor over the horizontal axis, and drag the selected polygons

horizontally toward the left to align them with LCD monitor, as shown in Figure 8-156.

Figure 8-156 The selected polygons of support in the Left viewport
 
25. Select the Polygon sub-object level in the modifier stack to deselect it.
 
Saving and Rendering the Scene
In this section, you will save the scene and then render it. You can also view the final rendered image
of this model by downloading the file c08_3dsmax_2015_rndr.zip from www.cadcim.com. The path
of the file is as follows: Textbooks > Animation and Visual Effects > 3ds Max > Autodesk 3ds Max
2015: A Comprehensive Guide
 
1. Choose Save from the Application menu.
 
2. Activate the Perspective viewport. Next, choose the Render Production tool from the Main

Toolbar; the Rendered Frame window is displayed. This window shows the final output of the
scene, refer to Figures 8-122 and 8-123.

 
Self-Evaluation Test
Answer the following questions and then compare them to those given at the end of this
chapter:
 
1. Which of the following options is used to modify the 3D mesh object by using sub-object levels?
 
(a) Convert to Editable Mesh (b) Convert to Editable Poly
(c) both (a) and (b) (d) None of these

2. Which of the following sub-objects is not a part of the editable poly objects?

232726
Cross-Out

232726
Inserted Text
ll




